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Windows 95 

hints 
OPENING A DOCUMENT 

Here is a trick way to open a 

document at a particular spot. 

Let’s say that you often work on 

a particular table. You could of 

course set a bookmark at the 

fable and then choose Edit Go 

To Bookmark. However, this 

trick will impress your friends! 

First, open the document in 

Word 95. Make sure that Word 

is not maximised, because you 

need to see the desktop. (If it is 

maximised, chck on the Re¬ 

store icon, ie the middle icon in 

the group of three on the right 

side of Word’s title bar.) 

Select the first part of the 

table or paragraph that you 

want to create the shortcut to, 

then right-drag it onto the 

CREATING A NEW 

FOLDER WHILE 

SAVING A FILE 

When you’re saving a document 

using the Save As command in 

E^pUcations that have been 

written especially for Wmdows 

96, you can create new folders 

at the same time. This is ideal if 

you come to save a file for the 

first time then realise you 

haven’t already created the 

folder for it. 

1 To create a new folder, choose 

the File Save As command in 

the application you are running. 

You’ll see a dialog box that’s 

similar to this, although the 

appearance will vary depending 

on the application you’re using: 

Inside this Issue Your screen should look 
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2 Select the folder in which you 

want to place the new folder. 

The selected folder should 

appear in the Save in box at the 

top of the dialog box. hi this 

example it’s the folder called PC. 

3 Click on the New Folder icon. 

You’ll see a dialog box that 

looks like this: 

FIGURE 3 
Choose ‘Create Document 

Shortcut Here’. 4 Ti^pe a name for the new folder. 

Now when you double- choose OK 

click on the shortcut, the You can now double-click 

document will open at the the folder to open it and then 

place that you highlighted. save the file. 



CLEARING THE 

DOCUMENTS IN THE 

START MENU 

If the documents that appear in 

the Start menu are outdated 

(you might have deleted them 

or moved them to a different 

location) you can clear them 

quickly and easily. 

1 Choose the Start menu, choose 

Settings, and then the Thskbar 

option. 

2 Choose the Start Menu Pro¬ 

grams tab. 

It should look like this: 

FIGURE 4 

3 Choose Clear then choose OK 

Now there wiU be no 

documents in the list 

ANIMATED CURSORS 

Do you want your mouse 

pointer to be a galloping horse 

or a dinosaur? ff you’ve installed 

Microsoft Plus! a number of 

animated cursors are available. 

To install an animated 

cursor, follow these steps. 

1 Click on the Start button and 

then choose Settings. 

2 Select the Control Panel option. 

The Control Panel window 

is displayed. 

3 Double-click on the Mouse icon. 

'The Mouse Properties dia¬ 

log box is displayed (Figure 5). 

4 Select the Pointers tab (Figure 6). 

This dialog box shows aU 

the different pointer types 

Windows uses. Unless you’ve 

already made any changes, the 

pointer types will be the 

defaults supplied by Microsoft. 
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5 Click on one ofthe pointer types 

such as Busy, then choose Browse. 

A dialog box like this appears: 

FIGURE 7 

6 Select, say, the Horse and then 

choose Open. 

7 Choose OK to close the Mouse 

Properties dialog box. 

■ Now whenever your system 

is busy the pointer will change 

to a running horse. 

SHORTCUTS TO 

EXPLORER 

Normally, if you start the Ex¬ 

plorer by clicking on Start, 

choosing iVograms and then 

choosing Windows Elxplorer, it 

starts with the focus at the root 

directory. If you right-dick on 

the Start folder and choose 

Explore, the active folder is the 

Start folder. 

But you may want to start 

the Explorer with a different 

folder active. For example, you 

may want to start the Explorer 

at the My Documents folder, or, 

if you retain compatibility with 

MS-DOS applications, at a folder 

called Document or Data 

There are several ways you 

can achieve that. Here’s a simple 

method that involves setting up 

a shortcut on your desktop. 

1 Right-click on Start then choose 

Explore to open the Explorer. 

2 Make sure that you can see the 

Desktop. (If the Elxplorer is 

maximised, click on the Restore 

icon, ie the middle icon of the 

group of three on the right side 

of the Explorer’s title bar.) 

If any other open applica¬ 

tions are in the way, for each 

one click on the Minimize icon 

(the leftmost icon of the group 

of three on the right side of the 

application’s title bar). 

3 In the Explorer, find the folder 

that you want the Explorer to 

start at 

4 Right-drag the folder to the 

desktop. When you let go, you’ll 

see a menu. 

5 Choose Create shortcut(s) here. 

You’ve now created a 

shortcut to the selected folder. 

6 Close the Explorer by clicking 

on the Close icon (the right¬ 

most icon of the group of three 

on the right side of the 

application’s title bar). 

If you hold down SHiFr and 

double-click on the shortcut 

you’ve just created, you’ll open 

the Explorer with the contents 

of that folder displayed in the 

Results window. 



Creating Access applimtkmfast 
Access 95 comes with some 

fantastic new features that help 

you create entire applications or 

forms, queries or reports within 

an application. 

In this tutorial you will 

follow the steps of creating an 

application and then altering the 

look of it slightly. 

You are going to create a 

simple application to keep track 

of your wine collection. How¬ 

ever, there are some much more 

sophisticated databases that 

you can create if you want to, 

such as the Time and Billing or 

the Contact Management 

databases. 

By exploring some of the 

new features in Access, you will 

also see how to tailor your 

application to your own needs. 

GETTING STARTED 

1 Start Microsoft Access 7 for 

Wmdows 96. 

2 Choose the Create a New Data¬ 

base Using the Database Wizard 

option and then choose OK 

The New dialog box is 

displayed. 

3 Select the Databases tab. 

A set of database wizards is 

displayed (Figure 1): 
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4 Select the Wine list wizard and 

then choose OK 

The File New Database 

window is displayed. Here you 

provide the file name that the 

database will be saved as. 

6 Enter the File name Wine, 

switch to the folder you want it 

to be created in and then choose 

Create. 

CREATING THE 

DATABASE 

The Database Wizard starts; 

FIGURE 2 

1 Choose Next. 

The tables that are to be 

created are shown. You want to 

add a field called Notes in the 

Wine list table. 

2 Make sure that the Wme list 

table is selected, then scroll the 

Fields in the table list to the 

bottom, then click in the check 

box next to Notes. Make sure 

that a tick appears. 

3 Choose Next 

4 Choose Stone from the Style list 

and then choose Next. 

5 Choose Soft Gray from the list 

of styles for printed reports then 

choose Next. 

6 Change the name to Wme 

Collection. 

This screen also allows you 

to include a picture. If you want 

to, complete the next 

instruction; if not, miss it out. 

7 Click on Yes, I’d like to include a 

picture, then click on the 

Picture button. Switch to the 

Clipart folder and choose the 

Wme picture if it is available. 

8 Choose Next, then choose 

Access now creates the 

tables, queries, forms and 

reports for your Wme Collection 

database. When the process is 

complete you’ll see a ‘Switch¬ 

board’ form and a nunimised 

database window (Figure 3). 

FIGURE 3 

ENTERING WINES 

You are now going to enter 

some data into your database. 

1 Click on the EnterWiew Wine 

List option. 

The Wme List form is 

displayed and the cursor is in 

the Wme Name field. You are 

going to enter information 

about your purchase of the 

classic Australian wine called 

Grange. 

2 Tlype Grange then press tab. 

3 TVpe Penf olds then press tab. 

4 Type 1971 then press tab. 

The cursor should now be 

in the Wme Type field. Notice 

that it has a drop-down list At 

present, the list has no values. 

5 Double-click in the field and a 

Wme Types form is displayed: 

FIGURE 4 

6 Type Shiraz. 

7 Close the form and then click 

on the down-arrow. 

Notice that Shiraz is now an 

entry in the list 

8 Choose Shiraz. 

9 In the Color field enter a colour 

of Dark Red. 

10 Choose Dry from the Sweet or 

Dry drop-down Ust. 

11 Filter Australia in the 

Country of Origin. 

Now you will enter the 

dates on which you bought 

bottles of this wine. 



12 Click in the Date Purchased 

field and enter 14/11/92, then 

enter a Unit IMce of $ 3 5 and a 

Quantity of 4. 

13 Press TAB then enter 12/10/94, 

$85 and 6. 

You have now entered the 

information about your Grange 

purchases. 

14 Close the form by double¬ 

clicking in the top left comer of 

the form or by clicking on the 

cross in the top right comer. 

ADDING VALUES TO 

THE DROP-DOWN LIST 

The form you have just entered 

data into used two drop-down 

lists. The first is driven by a 

table and the second by the 

properties of the field. You are 

going to add some extra wine 

tjpes to the table directly rather 

than using the form provided 

through the Switchboard. 

1 From the Window menu choose 

Wme: Database. 

The Database window is 

displayed. 

2 Select the Tables tab, select the 

Wme Ti'pes table and then 

choose Open. 

You can now see the table 

and the Shiraz entry. 

3 Add the following wine types. 

Riesling 

Cabernet Sauvignon 

Chardonnay 

Sauvignon Blanc 

Malbec 

4 Close the window. 

6 At the Switchboard choose 

Enter/View Wine Last. 

6 Click on the down-arrow next to 

Wine Type and notice that the 

new entries now appear. 

You are now going to see 

how the Sweet or Dry fist is 

created. 

7 From the View menu choose 

Form Design or click on the 

leftmost button on the Toolbar. 

You are now in Form Design 

8 Using the right mouse button, 

click once on the SweetorDry 

field (not the field name), then 

choose Properties from the pop¬ 

up menu. 

The properties for the field 

are displayed. Notice that the 

Row Source has the entries that 

9 Click at the end of the list in the 

Row Source field and type 

;Extra Brut 

10 Close the dialog box. From the 

View menu choose Form. 

11 Click on the Sweet or Dry drop¬ 

down fist and notice that the 

new value is displayed. 

12 Close the form. If you are asked 

to save the changes choose Yes. 

CHANGING A 

CONTROL TYPE 

A wonderful new feature of 

Access 7 is the ability to change 

a control’s type. 

You are going to create a 

new table with the names of the 

countries in it and then change 

the field so that you can choose 

from a fist. 

1 Switch to the Database window 

and select the Tables tab. 

2 Choose New then choose 

Design View then choose OK 

3 In the Field Name column, type 

Country ID. In the Data Type 

column choose AutoNumber 

flx)m the drop-down fist. 

4 In the next row, in the Field 

Name column enter Country 

name and then accept the 

default value of Text in the Data 

Type column. Set the Country 

ID field to be the indexed field 

by clicking in the field and then 

choosing Edit FYimary Key or by 

clicking on the Primary Key 

button on the Toolbar. 

5 Close the window and choose 

Yes to save the table. Enter the 

name Country in the Save As 

dialog box, then choose OK 

6 Open the table and add the 

countries Australia, Chile, 

Gennany, South Africa and 

Italy. Close the table. 

7 Return to the Switchboard and 

click on Enter/View Wine List. 

8 From the View menu choose 

Form Design then click once on 

the Country of Origin field. 

You are now going to 

change the control type. 

9 From the Format menu choose 

Change To and then choose 

Combo Box. 

10 Right-click the field and then 

choose Properties. 

Notice now that the Row 

Source Type is a Table or Query. 

11 Click once in the Row Source 

field. 

A drop-down arrow and a 

button with three dots on it 

appear. 

12 Click on the button with three 

dots on it 

A dialog box appears asking 

you to add a table. 

13 Choose Country then Close. 

You are switched to the 

QBE grid. 

14 Double-click on Country name 

to add it, then close the window. 

A message is displayed 

asking you to save the changes. 

15 Choose Yes. 

You are returned to the 

FYoperties sheet 

16 Close the FYoperties sheet 

17 From the View menu choose 

Form. 

18 Click on the down-arrow in the 

Coimtry of Origin field and the 

countries are now displayed. 

You have now successfully 

changed the data or the 

properties of three combo 

boxes as well as creating an 

entire application. Easy, isn’t it? 

You might now like to add 

some wines to the database and 

explore the reports that you can 

print from this database 

application. 
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Using multiple worksheets in an Excel 5 
or 95 workbook 
One of the powerful features 

that Microsoft introduced with 

Excel 6 was the ability to have 

multiple worksheets in a single 

workbook. This tutorial 

introduces some of the things 

you need to know if you want to 

take full advantage of multiple 

worksheets. In particular, you 

win learn about local and global 

naming of cells. 

GETTING STARTED 

1 Create a new worksheet and en¬ 

ter the data shown in Figure 1: 

^ Flange 

5 Drill bit 4.5. . .2150: .. 

■ Bl! 
FIGURE I 

Make sure that you have 

entered the data in the cells 

shown. 

2 Move the mouse pointer over 

the Sheetl tab at the bottom of 

the worksheet and then click 

with the right mouse button. 

A menu is displayed. 

3 Choose the Rename option. 

You’ll see this dialog box: 

FIGURE 2 

4 Tipe the name Catalogue 

and then choose OK 

The name of the worksheet 

changes to Catalogue. 

5 Click on the tab called Sheet2. 

A blank worksheet is 

displayed. 

6 In cell A1 type Company tax 

rate (%) andinBltype 15. 

7 Name this worksheet Tax 

Rates. You can either use the 

same technique as in steps 2 

and 3 or you can double-click 

on the Sheet2 tab to bring up 

the Rename Sheet dialog box. 

NAMING CELLS 

You are going to give a name to 

the cell with the tax rate in it, 

namely Bl. 

1 Select the cell Bl. Prom the 

Insert menu choose Name and 

then choose Define. 

Notice that the Refers to 

box shows the name of the 

worksheet (Tax Rates) followed 

by! and then the reference to 

the selected cell. 

2 In the Names in Workbook box, 

type the name TaxRate. 

The dialog box should look 

FIGURE 3 

3 Choose OK 

You should now be able to 

see the name displayed in the 

Name box just to the left of the 

formula bar. 

Tip: You could have simply typed the name in 

this area to name the cell. 

4 Click on the Catalogue tab at 

the bottom of the worksheet. 

5 Click on the cell B4 and then 

enter the name 

Catalogue! Markup in the 

Name box. 

6 Click on the down-arrow to the 

ri^t of the Name box and 

notice that the names Markup 

and TaxRate are displayed. 

7 Select the Tax Rates tab and 

then click on the down-arrow to 

the right of the Name box. 

Notice that only the Tax- 

Rate name is displayed. This is 

because you have created one 

name (ie TaxRate) as a global 

name and the other (ie Markup) 

as a local name. Global names 

are displayed in the Name box 

no matter which worksheet you 

are in. Local names are only 

displayed when you are in the 

worksheet where they are 

defined. 

You specify a name as being 

local to a worksheet by fyping 

the worksheet name followed 

by an exclamation mark 

followed by the name of the 

range or cell reference. All other 

names are global. 

Tip: If you tried to create a local name in the 

second worksheet, you would have to 

enclose the worksheet name in single 

inverted commas. That’s needed because 

there is a space in the name. For example, to 

create a local name called Ttest, you would 

select the cell and then type: 

'Tax Rates'ITest 

either in the Name box or by using the Insert 

Name command. 

ENTERING FORMULAS 

You are now going to enter the 

formula to calculate the selling 

price for each item. The selling 

price is calculated by adding the 

markup to the purchase price. 

1 Select the Catalogue worksheet 

then click in cell C7 and enter 

the following formula: 

=B7+B7*Markup 

2 Click in C7 and drag the 



AutoFill handle (the small 

marker in the bottom right 

comer of the cell cursor) down 

toC12. 

The formula is copied to 

each of the cells in the range 

C7:C12. 

3 Click in E7 and enter the 

following formula to calculate 

the total sales for each item: 

=C7*D7 

4 Use the AutoFiQ handle to copy 

this formula to the range 

E7:E12. 

You are now going to 

calculate the total profit before 

5 In the cell E14 click on the 

AutoSum button twice. 

The total sales before tax 

are displayed. 

6 Click in E16 and enter the 

following formula to calculate 

the profit after tax: 

=E14-E14*Taxrate 

Notice that because tax rate 

is a global name, you do not 

need to specify the worksheet. 

7 To see the implications of this, 

click on the Ikx Rates tab and 

in cell B3 type 100 

8 Now, in cell C3 enter the 

following formula: 

=B3 *markup 

Notice the error #NAME? 

appears. This error means that 

Excel does not recognise the 

name. It is a local name and so 

is not known to this worksheet. 

However, if you ever want 

to reference a local name on a 

‘ different worksheet you can. 

You simply have to type the fuU 

reference, including the 

worksheet name. 

9 Change the formula to: 

=B3 *Catalogue!markup 

Notice that Excel now 

knows about the name. 

The ability to differentiate 

between local and global names 

is very handy. Sometimes, you 

want to be able to reference a 

cell or a range that’s on one 

worksheet ftpm all other 

worksheets in the workbook. 

You would make its name 
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global. On other occasions, you 

want the name to be local to the 

worksheet. For example, if you 

have a workbook that has a 

different worksheet for 

calculating each month’s sales, 

you want the names you use for 

your calculations to be identical 

on each worksheet but unique 

to the worksheet. They would 

have to be local names. 

A final hint. If you define a 

global name and then use the 

same name to create a local 

name on a different worksheet, 

the local name takes 

precedence over the global 

name. 

FORMATTING THE 

CELLS 

Finally, we should improve the 

appearance of the figures in the 

Catalogue worksheet. At the 

same time, you’U revise some of 

Excel’s basic features. 

The dollar values in the 

Catalogue worksheet are not 

formatted very nicely at present, 

so you are going to display the 

values to two decimal places. 

1 Click on the Catalogue tab again 

then highlight the range C7:C12. 

2 Hold down the Ctrl key and 

highlight the range E7:E12. 

3 Keep the CTRL key down and 

click on E14 and E16. Let go of 

the CTRL key. 

4 Click on the Increase Decimal 

button. 

The values are now 

displayed to two decimal 

places. 

Copying a file 

in Windmos 95 
To copy a file from one folder 

to another on the same drive, 

hold down Ctrl and drag the 

file to the other folder. You will 

see a small + sign next to the 

mouse pointer. 

Using words 
forpage 
numbers in 
W(mi6&95 
Have you ever wanted to have 

your footers display the page 

number in words or roman 

numerals instead of numbers? 

If you have, then the solution 

outlined below may be just 

what you need. 

1 Open a document that has a 

few pages of text 

2 From the View menu choose 

Header and Footer. 

3 Click on the Switch Between 

Header and Footer button to 

switch to the footer area of 

the document 

4 TVpe the word Page followed 

by a space, then click on the 

Page Number icon. 

A field is inserted into 

your footer that will display 

the page number. 

5 Hold down alt and press F9 

to display the field code. 

You should see {PAGEj 

displayed. 

6 Click in between the word 

PAGE and the closing field 

bracket, press the spacebar 

and then type: 

\* CardText \*Caps 

7 Hold down alt and press F9 

to display the result of the 

field code. You may need to 

highlight the text and press P9 

to update the field code. 

You now have the format 

you require. The Card'Ifext 

switch displays the numbers 

as words and the Caps switch 

turns the first letter of each 

word in the result into a 

capital letter. 



Presentation hints for PowerPoint 95 

the bullet points on a slide, 

simply highlight the bullet 

points, then from the Format 

lU choose Periods: 

p In Selected Patagtaphs— 
Ut? pi PiiSSj 

UC Remove Periods 

i , 1 

Cancel | 

Select the Add Periods 

option and then choose OK 

Each of the points will now 

have a fiill stop at the end. 

You can use the same 

procedure to remove full stops. 

SELECTING HIDDEN 

OBJECTS 

You cah select objects on a slide 

by selecting one object and then 

pressing the tab key. This selects 

the next object in sequence. If 

you press tab and cannot see a 

selected object it means that 

there is a hidden object on the 

slide. You will be able to see the 

‘handles’ for the selected object. 

DRAGGING TO 

ANOTHER 

PRESENTATION 

If you drag a sUde from one 

presentation to another in Slide 

Sorter view, the sUde will be 

removed from the presentation 

you dragged it from. If you want 

the original slide to remain, 

simply hold down the Ctrl key 

when you drag. 

MOVING BETWEEN SELECTING A From the Format menu choose 

SLIDES SENTENCE Text Anchor. The Text Anchor 

When you are entering text into Select a sentence by holding dialog box is displayed: 

the body of a slide, simply hold down the CTRL key and clicking | 

down CTRL and press enter to somewhere in the sentence. AncNw Potrt. Fin 
move to the title text of the next Caned | 
slide. If there is no next slide a REMOVING THE NEW pSm Margins | 

new one is automatically SLIDE WINDOW 

created. If you don’t like the New Slide 

ADDING FULL STOPS 

window appearing whenever 

you create a new slide, from the 
i^foTTlcai 1 

If you decide that you need a Tools menu choose Options. r Adjust Objed Size to FS Text 

full stop at the end of each of The Options dialog box is f? Word-wrap Text m Object 

Select the General tab: 

^ Edit I View I Mvanwll 

P ShowStaitupfiialog 

p Show New Slide Dialog 

P Print in Background 

-p Recentlsi Used File tfet . fi 3 Entries 

T” Prompt for Fie Propertfes 

',P Full Text Search Information 

De-select the Show New 

Slide Dialog option. Choose OK 

Now, the new slide dialog 

will not be displayed unless you 

hold down shift when you 

choose New Slide from the 

Insert menu or click on the 

Insert New Slide button on the 

Toolbar. 

CENTRING BULLET 

POINTS 

When you create bullet points in 

the body of the slide, by default 

they start at the top of the 

“placeholder’ and move down. If 

you type only one or two points 

they appear at the top of the 

placeholder just under the title. 

If you would like the points 

to be centred in the placeholder 

as you type them, simply 

change the Text Anchor type. 

From the Text Anchor drop¬ 

down list, choose Middle, then 

choose OK 

SYNCHRONISING 

PRESENTATIONS 

If you have two similar pres¬ 

entations, you might want 

changes that you make to a 

slide in one presentation 

reflected in the same slide in the 

other presentation. This might 

hrqipen if you are preparing a 

presentation for your national 

managers, but you also want to 

give them a similar presentation 

that they can use to address 

their staff. 

Create your first presenta¬ 

tion and then create a blank 

second presentation. 

hi your first presentation, 

select the slides that you want 

to use in the second presenta¬ 

tion (using the SUde Sorter 

view). Hold down CTRL, drag 

the selected slides to the sec¬ 

ond presentation, and now hold 

down SHIFT as well as Ctrl 

before you drop the slides into 

the second presentation. 

The slides in the second 

presentation wfll now be linked 

to those in the first. Any 

changes that you make to the 

slides in the first presentation 

will be reflected in the slides in 

the second one. 

iC
Q

/V
M

U
N

lQ
U

E
 



Spinner 
controls in 
Excel 5 & 95 
Spinner controls are. ideal when 

you want to try many different 

values in a cell in order to see 

what effect changing the value 

has on other cells in the 

worksheet Ify the following 

hint to see how they work. 

To add a control to a 

worksheet, you need to display 

the Forms Toolbar. 

1 Create a new worksheet and 

enter the following data; 

59_3_1 

f 1 B- 1 1 -'c "1 

Interest Rate 5 

FIGURE 2 

8 Select the Control tab. 

9 Set the Minimum Value to 1, the 

Maximum Value to 15 and the 

Incremental Change value to 1. 

You are now going to tell 

Excel which cell is to change 

when you click on the Spinner 

control. 

10 In the Cell Link field, type B3. 

The Control tab should now 

look like Figure 3: 

Principal ^__J0000 

Interest j | 
FIGURE I 

2 In cell B9, enter the formula; 

=B3/100*B8 

3 Right-click somewhere on a 

Toolbar or from the View menu 

choose Toolbars. 

4 Choose Forms. (Then choose 

OK if the Toolbars dialog box is 

visible.) 

6 

7 

The Forms Toolbar appears 

(Figure 2). 

Click once on the Spinner 

control to select it 

Notice that it is pushed 

down and that the pointer has 

changed to a cross hair. 

Click and drag on the 

worksheet just to the right of 

the value in B3. 

Right-click the control and 

choose Format Object from the 

menu that is displayed. 

The Format Object dialog 

box is displayed. 

L±J 

FIGURE 3 

11 Choose OK 

You have now created a 

control. 

12 Click somewhere on the 

worksheet so that the spinner 

control is no longer selected. 

13 Now try moving the mouse 

pointer over the control. 

Notice that it changes to a 

‘finger’. 

14 Click on either button and 

notice that the value in B3 

changes and all cells that are 

dependent on that value also 

change! 
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